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Login 
1. Enter Username and password. 

Click on the Login Button. 
(Passwords must be at least 8 
characters, and contain an 
uppercase and lower-case letter, a 
number and a special character). 

2. Enter Two Factor authentication 
code, using the Win Auth code 
(Refer to NX Two-Factor 
Authentication (2FA) Setup 
Instructions).

Users with single location, will go directly to 
the main page. Users enrolled in multiple 
locations will see a list of enrolled locations. 
Select and double click the hospital from 
which you will be working during this login. 

*Location will appear on the child’s legal 
certified birth certificate- make sure to 
choose the correct birthing facility*



Home Screen

Main Menus: 

File - Create NEW birth events; Change User Location; Log Out

Search - Search for any registered birth records within 90 days from the date of birth. 

Batch - Create and print Summary of Fee Reports

Administration - Change Password

Help - Quick access to Birth Hospital User Manual, link to the Birth VR portal, etc. 

Announcement



Home Screen - Work Queues

Hospital users should regularly check 
their work queues for rejected records, 
as well as checking their pending queue 
to ensure that all records are filed within 
seven days after the birth. 

Number of Pending birth 
record(s)

Pending birth record(s)

Rejected birth record(s)



Record Organization 
Main Menu Image counts Notes Type of Alerts# of Alerts

Field

Paragraph (blue titled section)

Not applicable for entry (grayed out)

TabRecord ID



Basic Conventions
 Date Fields - Slashes for date fields are masked in- just type the numerals or click on the calendar. MM/DD/YYYY 

 Hyphens for any numeric field are masked in-just type the numerals.

 <Tabbing> between fields is the MOST efficient. However, the mouse can be used to click into the next field, but 
validation messages may appear if the User skips around. 

 File>Save Without Edits: To avoid the system running through the validation edits when the record is not complete, 
go to the main menu bar and select save without edits or press and hold CTRL+2.

 Hovering on the field name will describe what is required in the field.

 “Paragraphs” are blue titled sections that contain one or more fields. 

 Some fields are boxes that require only a single letter entry. The fields are not case-sensitive. 

 Some items are selected via drop-down lists. Click arrow to see list of drop-down options.

 The orange color highlight field indicates the item is not listed in the drop down.   



Basic Conventions - Keyboard Shortcuts

 Start a New Birth Record…............ CTRL + I

 Save…………………………………. CTRL + S

 Save Without Edits…………………. CTRL + 2

 Move to Next Field……….............. <Tab> key

 Move to Previous Field……………. Shift +<Tab> key

 Clears a field where the cursor is… CTRL + Z

 Select a checkbox………………….. Press spacebar if cursor is in the field or click with 
  mouse to select or unselect.

 Close Window………………………..Alt + F4



Basic Conventions - Dates

T = Today’s Date

B = Back, continue pressing “B” for each day backward

9 = Unknown

   = Visual calendar

Today = T on the keyboard     Yesterday = B once on the keyboard 

Unknown = 9’s  Visual calendar = 



Basic Conventions - Names
 Enter names and literal fields as upper and lowercase letters. The system will default the title case to a capital letter.
 If there is a capital letter within the name, right click and chose “IGNORE CASE RULE” to add another capital letter. 

Example: McMichael, McMahon, McKayla, etc. 
 If no first or middle name are given by parents, select the checkbox “No First Name”. 

 To add name later, parents will complete the Affidavit to Add Given Name form to amend the birth certificate, 
which can add first and/or middle name within the first year of birth. A legal change of name through the 
courts will be required to add name after one year.  

 No Social Security Number will be assigned. 
  Enter characters that are LETTERS on English keyboard. 

 An apostrophe, hyphen, and spaces may be used. 
 Do NOT use an apostrophe in the name as a substitute for a special character. 
 Enter English-alpha characters only. 

 Enter what the parents wrote on the Birth Mother’s Worksheet. 
 Enter a hyphen only if the parent puts a hyphen in a name on the birth worksheet
 Fields can accommodate lengthy names within reason. 

UNACCEPTABLE:
• No nicknames
• No abbreviations, except for generational suffix
• No special characters including diacritical or accent marks 
• No parentheses within or around a name
• No quotations mark enclosures
• No numbers 
• No courtesy, processional, or academic titles before or after a name (e.g., Ms., Mrs., Dr., MD, DO, PhD, etc.) 



Validation Edits
Validation edits will appear upon existing fields, as well as upon saving a record as complete, when the date entry is 
incorrect, questionable, or erroneous. 

Re-Key: Select Re-Key to return to the field and re-enter it. 

Overridden: If the value was questionable but the medical charts indicates to be true, user can override the field. A 
notation on the record in IVES is required. The record will be reviewed by the State for acceptance.

Overridden –Not Queried: Users can override the field. A notation on the record in IVES is required. The record 
will be reviewed by the State for acceptance.

Queried and Verified: When the value is questionable, but the medical charts indicates that it is true as entered, 
the user select Queried and Verified. A notation on the record in IVES is required. The record will be reviewed by 
the State for acceptance.

Queried - Not Verified: The user did not verify the values. A notation on the record in IVES is required. The record 
will be reviewed by the State for acceptance.

Action Buttons

Error Message

Field Information



Creating Notes 

Notes are used for clarification, or justification for overriding a validation with a Queried and Verified. 

Place the cursor on the field that 
requires an explanation and right-
click on the mouse to display the 
drop-down options. Select “Notes”

Click the ‘New’ button 



Creating Notes - Continues

Enter Birth-Registration in the Security 
Function field. Type the message in the 
open field. Click the blue save button. 

Note results appears, showing the field note 
is addressing the notation and the 
username that created the note. Click the 
blue close button.  

Located on the upper right corner of the 
birth record the notes count will reflect the 
added note on the record. 



Creating a New Birth Record

From the Home menu bar, select 

File New  Birth (or press CTRL +1)

Tabbing between fields is generally the most 
efficient. 

The information for data entry will be found on page one of the Mother’s Birth Worksheet, except for place and type of 
birth. The type of place is on the first page of the Hospital Medical Worksheet, and the place of birth is prepopulated based 
on user login. 

Hospitals may enter records for birth occurring at, or en route to their hospitals. 

If baby is born at home and transferred to hospital, begin the registration, but DO NOT sign off to complete. Contact the 
Birth Registration team at the Bureau of Health Statistics at 515-725-2522, and they will complete the record. 



Creating a New Birth Record
The “Child” tab matches items from the first page of the Mother’s Birth Worksheet. 



Child - Duplicate Checking
Begin the New birth record by enter the duplicate check information. Then click on the Check for Duplicate button.

The information from the duplicate check will automatically fill in the “Child’s Information” fields. Case rule will not copy. 
Make sure to right click, ignore casing rule to capitalize a letter within a name. Enter the infant’s generational suffix, if 
applicable. 

Verify the child’s name as indicated by the informant on the Birth Mother’s Worksheet. The child’s name will appear on the 
child’s legal certified birth certificate. 

Also verify the child’s date of birth with the hospital records to ensure accuracy. The system will not accept a future date, 
nor a date more than one year in the past. 



Child - Place of Birth 

The hospital information is pre-populated based on the hospital’s user agreement and enrollment. The name of the hospital 
and the county of birth will appear on the child’s legal birth certificate. 

Tab through the fields to get to the next applicable field, Mother Tab. 

The “Type of place of birth” defaults to “Hospital” but may be 
changed to “En route” via the drop-down list, if applicable. 

Press the H on the keyboard twice to change the dropdown option to 
“Hospital-En route to.”



Mother

The Mother tab matches the mother’s information on page 1 of the Birth Mother’s Worksheet. 



Mother - Medical Record Numbers

The first paragraph on the Mother tab are the medical record numbers. 

Enter both the infant’s number and the mother’s number from the hospital’s medical record labels on the birth 
worksheet. 

If tabbing to fast between fields, it may inadvertently skip the infant’s medical record number field. 

SHIFT + TAB to go back one field or use the mouse to put your cursor back in the field. No validation edit will appear 
unless you've already reached a required field, in which case just answer the questions, then go back instead of 
TABBIING forward. 



Mother - Preferred Parentage Title 

The parentage title defaults to Mother. Tab past if this is what the 
information indicated on the Birth Mother’s Worksheet. 

If the birth mother wishes to be called “Parent,” clear the field, and 
type parent, or click the dropdown and click on Parent from the list. 

The selected parentage title will appear on the child’s legal certified birth certificate. 



Mother - Mother’s Current Legal Name 

Enter the mother’s current legal first, middle, and last name in upper and lowercase. Tab past the middle name if none 
is provided by the informant. 

If applicable, enter the generational suffix; otherwise, tab past it.  

First and Last names are required fields. 

An apostrophe, hyphen, and spaces may be used. The following are not allowed: nicknames, abbreviations, special 
characters, including diacritical, accent marks, or any name enclosed in quotations or parentheses. 

Please verify the mother’s name as indicated on the Birth Mother’s Worksheet. The mother’s name will appear on the 
child’s legal certified birth certificate. 



Mother - Residence Address

Enter the mother’s current residence address, include the apartment or lot 
number (if applicable) on Street Address Line 1. Do not enter the apt, lot or unit 
number on line 2.  

Tab to the field labeled “Residence Country” select the country where the 
mother’s residence is located from the dropdown list. The field defaults to United 
States. Tab past if this is correct.

If the mother’s legal residence is not located in the United States, begin typing the 
name of the country until you reach the intended entry. If the foreign country is not 
on the list, type in the country. 

Enter the City, County and Zip Code.

Please verify your selection. The state of the mother’s residence will appear on the child’s legal certified 
birth certificate (or the name of the foreign country). 



Mother - Residence Address

Enter the “Inside City Limits” item by pressing the first letter of the answer on the keyboard. It is not case sensitive. If the 
informant indicates “Don’t Know” or fails to answer the questions, and you are familiar with the city limits of their city, please 
select the most accurate answer rather than entering “Don’t Know”, or “ Unobtainable”. 
 Y= Yes, inside city limits
 N= No, not inside city limits
 D= Don’t know if inside city limits
 U= Unobtainable 

Tab to phone number field and enter as provided by the Informant. The phone number is optional data. The parentheses 
and hyphens are mask in. 

If you enter “Don’t Know”, or “Unobtainable” a validation edit will 
appear upon exiting the field requesting you to verify entry. You must 
then either select Re-Key, Skip (and come back to later), Queried 
and Verified, or Queried and Not Verified. 



Mother - Mailing Address

IF THE MOTHERS MAILING ADDRESS IS THE SAME AS HER RESIDENCE ADDRESS: 

Tab to the “Copy Residence to Address to Mailing” bar in the mailing address paragraph and press the space bar or click 
with the mouse to copy the residence address over. 

Either Tab through the mailing address fields, or use the mouse to open the Mother page 2 tab. 

IF THE MOTHER’S MAILING ADDRESS IS DIFFERENT FROM HER RESIDENCE ADDRESS:
 Enter the address the same manner as the residence address, make sure to include the apartment, lot number, or unit 
number (if applicable) on street address line 1. 

*If address is not entered correctly, this effects the delivery of the birth certificate, as well as the Social Security 
Card. Please double check to make sure address is entered correctly.* 



Mother Pg 2

The Mother pg 2 tab matches the first half of the items on page 2 of the Birth Mother’s Worksheet. 



Mother Pg 2 - Country of Birth 

Tabbing into the Mother pg 2 takes the user to the birth mother’s country of birth field in the mother’s demographics: 
birth/language/education paragraph. 

The country of birth defaults to United States. If the mother was born in the United States, tab to the state of birth field. 

If the mother was born in a foreign country, type the name of the country from the dropdown. If the foreign country does 
not appear on the dropdown, type the name of the country in the field. 

Please verify your entry’s. The mother’s state of birth will appear on the child’s legal certified birth certificate. 



Mother Pg 2 - State of Birth 

If the mother was born in the United States or a U.S. Territory, select the birth mother’s state of birth from the dropdown list 
of states and territories. 

If the mother is born in Canada, tab to the State of birth field and select the name of the Canadian Province as provided by 
the informant on the Mother’s Birth Worksheet. 

If the mother was born in any other foreign county, tab past the state of birth field since it is not applicable. The name of the 
foreign county will print on the child’s certified birth certificate as the mother’s birthplace. 

Please verify your entry’s. The mother’s state of birth will appear on the child’s legal certified birth certificate. 



Mother Pg 2 - Date of Birth 

Enter the date provided by the informant on the Birth Mother’s Worksheet. MM/DD/YYYY 

Tab to the next field. A slight lag occurs while the system calculates and auto-fills the mother’s age. The age is calculated 
using this date and the Infant’s date of birth. 

Be sure to proof the data of the parent’s dates of birth, they appear on the child’s legal certified
birth certificate. These dates are among the most common typographical errors, causing the parent
to send requests for corrections. 

If the informant fails to provide the mother’s date of birth, make an attempt to locate it, including contacting the State birth 
registration staff to see if the mother was born in Iowa. If all efforts fail, enter all 9’s for the date. A validation edit will appear 
since this is required field, and user should make a note in the record. 

A validation edit will appear if the birth mother’s calculated age falls outside the acceptable limits of age 13 to 65.



Mother Pg 2 - Language 

Tab to the mother’s primary/preferred language. Type in the language that the informant wrote on the birth worksheet in the 
space provided. 

If the mother failed to provide a specific language, type in “Unknown” in the field. 



Mother Pg 2 - Education  

Tab out of the Mother’s primary/preferred language to education level field. Choose form the dropdown list or press the 
character on the keyboard that corresponds with the first character of the option indicated by the informant on the Birth 
Mother’s Worksheet, then tab to the next paragraph.  

A validation edit will appear if the mother’s calculated age and her education level are out of 
the acceptable range. Either the mother’s date of birth or her education level must be
corrected. 



Mother Pg 2 – Hispanic Origin
Tabbing out of the Education reaches the Mother’s Hispanic origin. Press the letter Y on the keyboard for “Yes”, N for “No” or U 
for “Unknown.” 

If “No,” birth mother is not of Hispanic origin, the remaining items in the 
paragraph will auto-fill.

If the Hispanic origin is “unknown,” the remaining items in the 
paragraph will auto-fill.

If “Yes,” birth mother is of Hispanic origin, Tab to the origin type indicated by the 
informant on the Birth Mother’s worksheet in the mother’s and enter a Y. If “Other”, 
answer Y, then enter the origin in the Specify field.



Mother Pg 2 - Race

Tab to Is Race Unobtainable? field. 

If “Yes” the race is unobtainable, enter a Y in the “Is Race Unobtainable” field, the remaining items will auto-disable, and 
each race item field will be grayed out. 

If the race can be obtained, enter a N for “No” in the “Is Race Unobtainable field” all the race types will open. 

 Tab to the race type indicated by the Informant on the Mother’s Birth Worksheet in the mother’s race and enter a Y for 
“Yes”. More than one race may be selected. 

 If ”American Indian/Alaska Native, Other Asian, Other Pacific Islander, or Other Race” answer Y, then enter in the 
specify field. 



Mother Pg 3
The Mother pg 3 tab matches the second half of the items on page 2 of the Mother’s Birth Worksheet



Mother Pg 3 - WIC

Enter the “WIC” item by pressing the first letter of the answer on the keyboard. It is not case-sensitive. 

 Y= Yes  D= Don’t Know

 N= No  U= Unobtainable

If “Don’t Know” or “Unobtainable” is entered, it will appear a 
validation edit. Either Re-Key if an error or select Queried 
and Verified if the data-entry is correct. 



Mother Pg 3 - Tobacco Usage

Answer the tobacco usage item by pressing the first letter of the answer on the keyboard. If is not case-sensitive. 

 Y= Yes     D= Don’t Know

 N= No      U= Unobtainable

Zeros will auto-fill in the time period fields when the user selects N for “No” and forwards the cursor to the next paragraph. 

If the mother used tobacco (not including vape) during the time periods indicated, select Y for “Yes” and Tab to provide an 
answer for each trimester period. 

An amount of more than zero must be entered for at least one of the time periods; otherwise, a validation edit will appear, 
forcing the user to go back and enter a positive number



Mother Pg 3 - Height

Enter whole numbers for the height only. If either the of feet or inches 
gives a range, enter the highest value. 

Enter 9’s in each field if the mother did not answer the question on the 
Birth Mother’s Worksheet. If possible, obtain the data from the mother’s 
prenatal chart. 

Tabbing from height moves the cursor forward to the pre-pregnancy 
weight. 

A validation edit will appear if the field is left 
blank 



Mother Pg 3 – Pre Pregnancy Weight

Enter whole numbers for the pre-pregnancy weight. If a range is provided, enter the 
highest value.  

Enter 999 if the mother did not answer the question on the Mother’s Birth Worksheet. If 
possible, obtain the data from the mother’s prenatal chart. 

Tabbing from pre-pregnancy weight moves the cursor forward to the marital status. 

A validation edit will appear if the field is left blank or the weight is less 
than 75 or more than 350 pounds, or if there is a weight loss. If 
correct, make a note in the record. 



Mother Pg 3 - Marital Status 

Enter Y for “Yes” N for “No” or U for “Unknown” if the birth mother has ever been legally married. 

 If Yes, Tab to the next marital question

 If No, birth mother has never been married, the next marital question will auto fill. Tabbing forward will skip it. 

 If Unknown that birth mother has ever been married, the next marital question will auto fill. Tabbing forward will skip it. 

Enter Y for “Yes” N for “No” or “U” for unknown if the birth mother was legally married at the time of conception, birth, or 
anytime between. 

 If Yes, birth mother was legally married at time of conception, birth or anytime between, the paternity question will auto 
fill. Tabbing forward will skip it. 

 If No, birth mother was NOT legally married at the time of conception, birth, or anytime between, Tab to the paternity 
questions. 

 If Unknown that birth mother was legally married at time of conception, birth or anytime between, the paternity questions 
will auto fill. Tabbing forward with skip it. 



Mother Pg 3 - Marital Status 

Enter Y for “Yes” N for “No” or U for “Unknown” if the informant indicated that a Paternity Affidavit was being completed. 
Tabbing forward will skip the spouse’s information obtainable check box.  

Enter Y for “Yes” N for “No” for spouse’s information unobtainable if: 

 Birth Mother is married but refuses to provide her legal spouse’s information due to separation or pending divorce, and 
the spouse is not the biological father. 

 Birth Mother is a surrogate gestational carrier, and she is married, but refuses to provide her legal spouse's information. 

If spouse’s information is unobtainable, hospital staff will need to include a note to confirm why birth mother refuses to 
provide the information. 

Hospital staff should make all attempts to obtain the spouse’s information if birth mother is married. 



Mother Pg 3 - Maiden Name  

Enter the mother’s maiden legal first, middle, and last name in upper and lowercase. 
Tab past the middle name if none is provided by the informant.   Ensure the name 
matches on the Birth Mother’s Worksheet. 

If applicable, enter the generational suffix; otherwise, tab past it.  

An apostrophe, hyphen, and spaces may be used. The following are not allowed: 
nicknames, abbreviations, special characters, including diacritical, accent marks, or any 
name enclosed in quotations or parentheses. 

Please verify the mother’s name as indicated on the Birth Mother’s Worksheet. The 
mother’s name will appear on the child’s legal certified birth certificate. 

A validation edit will appear if the marital status equals “Yes” and the mother’s surname 
prior to any marriage is the same as her current surname. Double-check with the 
mother to verify. Make note if the name is different from current name, and it is correct. 



Mother Pg 3 - Social Security Number

Press the spacebar or click on the “SSN not obtainable” checkbox if the mother does NOT have a valid Social Security 
Number. The SSN will auto-fill with 9’s to indicate “Unknown” as the cursor forwards to the next field. 

If the birth mother has a Social Security Number, tab out of the “Social Security Number Not Obtainable” checkbox, and 
enter the number as provided by the informant on the birth worksheet. The hyphens will mask in. 



Spouse
The Spouse tab matches the Spouse items on page 3 of the Birth Mother’s Worksheet. 

Complete only if the mother is legally married and provides the spouse information. 



Spouse - Preferred Parentage Title

The parentage title defaults to Father. Tab past if this is what 
the information indicated on the Birth Mother’s Worksheet, 
otherwise select a different option from the drop-down list. 

Press the letter M for “Mother” or P for “Parent” (most likely 
chosen by same-sex female spouses) as indicated by the 
informant on the Birth Mother’s Worksheet. 

The selected parentage title will appear on 
the child’s legal certified birth certificate. 



Spouse - Current Legal Name 

Enter the spouse’s current legal first, middle, and last name in upper and lowercase. Tab past the middle name if none is 
provided by the Informant. If applicable, enter the generational suffix; otherwise, tab past. 

An apostrophe, hyphen, and spaces may be used. The following are not allowed: nicknames, abbreviations, special 
characters, including diacritical, accent marks, or any name enclosed in quotations or parentheses. 

Please verify the spouse’s name as indicated on the Birth Mother’s Worksheet. The spouse’s name will appear on the 
child’s legal certified birth certificate. 



Spouse - Name Prior to Marriage 

If the spouse’s name prior to any marriage is the same as their current legal name, click on the “Copy Legal Name to Prior 
Name” bar. This will copy the spouse’s legal name to the appropriate field. Case rule will not copy. Make sure to right click, 
ignore casing rule to capitalize a letter within a name. 

If any part of their name prior to any marriages is different than their current name, tab past the “Copy Legal Name to Prior 
Name” bar to the first name field to enter the names as provided by the informant on the Birth Mother’s Worksheet. 

Please verify the spouse’s name as indicated on the Birth Mother's Worksheet. The spouse’s name will appear on the child’s 
legal certified birth certificate. 



Spouse - Country of Birth 

Tabbing out of the spouse’s name takes the user to the Spouse’s Country of Birth field. 

The country of birth defaults to United States. If the spouse was born the United States, Tab to the state of birth field. 

If the spouse was born in a foreign county, select the country from the dropdown. To 
avoid scrolling, begin typing the name of the country until the dropdown finds it. 

If the foreign country does not appear on the dropdown, enter the country name in 
the field provided. 



Spouse - State of Birth

Tab to the State of birth field. If born in the United State or a U.S. Territory, select the spouse’s state of birth from the 
dropdown list of states and territories. 

If the spouse was born in Canada, tab to the State of birth field and select the name of the Canadian Province as provided 
by the informant on the Birth Mother’s Worksheet. 

If the spouse was born in any other foreign county, tab past the State of birth field since it is not applicable. 

Please verify entry. The spouse’s state of birth, or the name of foreign 
country will appear on the child’s legal certified birth certificate. 



Spouse - Date of Birth 

Tab to the Spouse’s Date of Birth. Enter the date provided by the informant on the Birth Mother’s worksheet.  MM/DD/YYYY.  
There may be a slight lag while the system calculates and auto-fills the spouse’s age.  

If the informant fails to provide the Spouse’s date of birth, make an attempt to locate it, including contacting the state birth 
registration staff to see if the spouse was born in Iowa.  

If all efforts fail, enter all 9”s for the date.  A validation edit will appear since this field is required, and staff should make a 
notation.

A validation edit will appear if the Spouse’s calculated age falls outside the acceptable limits of age 13 and 65. 

Be sure to proof the data – the parents’ dates of birth appear on the child’s legal certified birth certificate, but are also among 
the most common typographical errors, causing the parent to send requests for corrections.



Spouse - Social Security Number 

Tabbing out of the Spouse’s Date of Birth reaches the Spouse’s SSN paragraph. 

Press the spacebar or click on the “Social Security Not Obtainable” checkbox if the spouse does NOT have a valid Social 
Security Number. The SSN will auto-fill with 9’s to indicate “Unknown” as the cursor forwards to the next field. 

If the spouse has a Social Security Number, Tab out of the “Social Security Number Not Obtainable” checkbox and enter 
the number as provided by the informant on the Birth Worksheet. The hyphens will mask in. 

Double check with the parent for the correct Social Security Number. 



Spouse - Education 

Tabbing out of the Spouse’s SSN reaches to the education field. 

Press the character on the keyboard that corresponds with the first character of the option indicated by the Informant 
on the Birth Mother’s Worksheet, then tab to forward the cursor to the next paragraph. 

A validation edit will appear if the spouse’s calculated age and education level are out of the acceptable range. Either 
the spouse’s date of birth or education level must be corrected. 



Spouse - Hispanic Origin 
Tabbing out of the education reaches the spouse’s Hispanic Origin. Press the letter Y on the keyboard for the “Yes” N for 
“No” or U for “Unknown”. 

If “No,” spouse is not of Hispanic origin, the remaining items in the 
paragraph will auto-fill.

If “Yes,” spouse is of Hispanic origin, Tab to the origin type indicated by the 
informant on the Birth Mother’s worksheet in the mother’s and enter a Y. If 
“Other”, answer Y, then enter the origin in the Specify field.

If the Hispanic origin is “unknown,” the remaining items in the 
paragraph will auto-fill.



Spouse - Race 

Tab to the Is Race Unobtainable field. 

If “Yes” the race is unobtainable, enter a Y in the “Is Race Unobtainable?” field, the remaining items will auto-disable. Each race 
item field will be grayed out. 

If the race can be obtained, enter a N for “No” in the “Is Race Unobtainable?” field, all the race types will open. 
• Tab to the race type indicated by the informant on the Birth Mother’s Worksheet and enter a Y for “Yes” More than 

one race can be selected. 

• If “American Indian/Alaska Native, Other Asian, Other Pacific Islander or Other Race”, answer Y, then enter in the 
Specify field. 



Spouse - Language 

Tab to the spouse’s primary/preferred language, and type in the preferred language 
that is written on the Birth Mother’s Worksheet. 



Informant  
The Informant Tab matches the information on page 4 of the Birth Mother’s Worksheet. 



Informant - Adoption Pending

Tabbing from the spouse’s language forwards the cursor forward to the adoption field on the Informant tab.

Answer the “Baby is Being Given Up for Adoption” item by pressing the first letter of the answer on the keyboard 
Y for “Yes” N for “No” and U for “Unobtainable” . 

Double check Birth Mother's Worksheet and the discharge status. 

Enter N, if the mother is maintaining custody of the baby and does 
NOT intend to give the baby up for adoption. 

If the birth mother intends to give the baby up for adoption, enter Y.    
A validation message confirming the mother is giving the baby up for 
adoption. Click the OK button if correct. If NOT, change the answer to 
No. 



Informant - Child’s SSN 

Tabbing out of adoption pending forwards the cursor to the Social Security Number field. 

Enter Y if the informant indicated “Yes”. 
 
Enter N only if the informant indicated “No” on the Birth Mother’s Worksheet, or if there is a Surrogacy, or Adoption. 

Enter U for “Unknown”, this will appear a validation error. 

A validation edit will appear if you either forget to answer the question or enter 
U for “Unknown”. 



Informant - Relationship & Name 

Tabbing out of Social Security Number forwards the cursor to the “Informant’s Relationship to the Baby’s Mother?” field. 

The informant's relationship field defaults to “self” and populates the birth mother’s name in the field. 

If the informant is someone other than the birth mother, choose from the dropdown list of the “Informant’s Relationship 
to the Baby’s Mother” field. Enter the first, middle (if applicable) and the last name of the informant other than the birth 
mother. 

If the informant is other than what is listed on the Informant Relationship to the Baby's Mother dropdown, enter the 
relationship. Then enter the first, middle (if applicable), last name of the informant other than the birth mother. 



Informant - Address

If birth mother or spouse is the informant and the address is the same as the residence address, press “Copy 
Mother’s Address to Informant” bar to copy the address into the informant’s address fields. 

If the informant is someone other than the birth mother and spouse, tab into the address field and enter their mailing 
address. 

Tab to the “Informant Signed?” and “Date Signed” paragraph. 



Informant - Signed & Dated 

Tabbing out of the informant’s address forwards the cursor to the “Informant Signed & Date signed” 
paragraph. 

Enter Y for “Yes” when the informant has properly signed and dated the Birth Mother’s Worksheet. 

Tab to the Date signed field and enter the date of the birth mother signed on the Birth Mother’s Worksheet. 
(MM/DD/YYYY)

A validation edit will appear if the date is not completed. 
Enter the child’s date of birth if the informant signed the 
worksheet but forgot to provide the date signed. 



Prenatal 
The Prenatal Tab matches prenatal items on page 1 of the Hospital Medical Worksheet. 



Prenatal - Prenatal Care

Prenatal Care is the first paragraph on the Prenatal tab. The cursor will be on the No Prenatal Care field. 

If prenatal care was NOT indicated in the mother’s medical charts, enter a Y for “Yes” in the No Prenatal Care field. The 
Date of First Prenatal Care Visit and the Total Prenatal Visits fields will auto-disable. 

If prenatal care is indicated in the mother’s medical charts, enter N for “No” in the “No Prenatal Care” field. 
• Tab to the “Date of First Visit” filed and enter the date of first visit (MM/DD/YYYY).  If part of the date is not known, 

enter 9’s for the part of the date not known. 

• Tab to the “Total Prenatal Visits” field and enter the number of total visits. 

Research medical records for the correct data when possible. 



Prenatal - Last Normal Menses 

Enter the date of the last menses as located in the mother’s prenatal chart (MM/DD/YYYY). 

If none of the date is known, enter all 9’s in the date field. A validation will appear if the date is unknown, click OK. Add a 
note to the record as to why the menses date is unknown. 

Research medical records for the correct date when possible. 



Prenatal - Previous Live Births 
If there are NO previous live births indicated in the mother’s medical charts, enter Y for “Yes” in the No Previous Live 
Births field. The Number of Previous Live Births-Now Living, Number of Previous Live Births-Now Deceased, and Date of 
last live birth fields will auto-disable (gray out). 

If there are previous live births as indicated in the mother’s medical charts, enter N for “No” in the “No Previous Live 
Birth” field. 

• Tab to the “Number of Previous Live Birth-Now Living” field and enter total numbers of previous live births.

• Tab to the “Number of Previous Live Births-Now Deceased” field and enter total numbers of deceased births. If there 
is no mention of a previous live birth now deceased documented in the mother’s prenatal charts enter zero.(0)

• Tab to the “Date of Last Live Birth” field and enter the date of the last live birth (MM/DD/YYYY). Enter 9’s in the 
month, date, or year if date is not known.   



Prenatal - Other Pregnancy Outcomes

If there are NO other pregnancy outcomes not resulting in live birth indicated in the mother’s medical chats, enter Y for 
“Yes” in the “No Other Pregnancy Outcomes Not Resulting in Live Birth” field. The Total Number of Other Pregnancy 
Outcomes and the Date of Last Other Pregnancy Outcomes will auto-disable. (gray out). 

If there are other pregnancy outcomes not resulting in live birth as indicated in the mother’s medical charts, enter N for 
“No” in the No Other Pregnancy Outcomes Not Resulting in Live Birth. 

• Tab to the “Total number of other pregnancy outcomes” field and enter total numbers of pregnancy outcomes. 

• Tab to the “Date of last other pregnancy outcome” field. Enter the date of the last other pregnancy outcome 
(MM/DD/YYYY). Enter 9’s in the month, date, or year if date is not known.   



Prenatal - No Risk Factors

Tab to the “No Risk Factors Present in this Pregnancy” field.

If there were no risk factors indicated in the mother’s medical charts, enter Y for “Yes” in the “NO Risk Factors Present in 
This Pregnancy statement” field. The remaining items will auto-disable. Each risk factor items field will be grayed out. 



Prenatal - Risk Factors

If risk factors were indicated in the mother’s medical charts, enter N for “No” in the “NO Risk Factors Present in This 
Pregnancy” statement field. All the risk factor fields will open. Tab to the risk factor items indicated in the mother’s 
medical chart and enter a Y for “Yes”. Select as many options that apply to this pregnancy. 

Diabetes and hypertension both have sub-categories. N for “No” is defaulted and no further action is required if the birth 
mother did not have diabetes or hypertension. However, if either diabetes or hypertension is documented in the mother’s 
medical charts, select one of the sub-category options. Only one may be selected. 

The “Pregnancy Resulted from Infertility Treatment” fields have two additional options. Select one or both as applicable. 



Prenatal - No Infections

Tab to the “No Infections Present And/or Treated During this Pregnancy” field. 

If there are no infections indicated in the mother’s medical charts, enter Y for “Yes” in the “NO Infections Present And/or 
Treated During This Pregnancy” field. The remaining items will auto-disable. Each infection item field will be grayed out.  



Prenatal - Infections
If there are infections indicated in the mother’s medical charts, enter N for “No” in the NO “Infections Present And/or 
Treated During This Pregnancy field”.  All the infection fields will open.  

Tab to the infection items indicated in the mother’s medical chart and enter a Y for “Yes”. Indicate as many options that 
apply to this pregnancy. 

A validation message for Hepatitis B and Hepatitis C will 
appear. Check mother’s medical chart. Click 1 to override 
if correct. 



Prenatal - Obstetric Procedures
If none of the obstetric procedures listed were indicated in the mother’s medical charts, enter Y for “Yes” in the “NO Obstetric 
Procedures During This Pregnancy” field. The remaining items will auto-disable. Each obstetric procedure item field will be 
grayed out.

 

If obstetric procedures were indicated in the mother’s medical charts, enter N for “No” in the “NO Obstetric Procedures 
During This Pregnancy” field. All the obstetric fields will open.  

Tab to the obstetric procedure items indicated in the mother’s medical charts and enter a Y for “Yes”. Indicate as many 
options that apply to this pregnancy. 

If the External Cephalic Version procedure took place, indicate whether the procedure was a success or failure. 



Labor & Delivery 
The “Labor & Delivery” tab matches the first half of the Labor & Delivery items on page 2 of the Hospital Medical 
Worksheet. 



Labor & Delivery - Onset of Labor
If none of the Onset of Labor options were indicated in the mother’s medical charts, enter Y for “Yes” in the “No Onset of 
Labor Issues Noted For This Pregnancy” statement field. The remaining items will auto-disable. Each Onset of Labor 
Issues fields will gray out. 

Tab to the infection items indicated in the mother’s medical charts and enter a Y for “Yes”. Indicate as many options that 
apply to this pregnancy. 

If onset of labor were indicated in the mother’s medical charts, enter N for “No” in the No Onset of Labor Issues Noted For 
This Pregnancy. All the obstetric fields will open.  

Tab to the onset of labor item indicated in the mother’s medical charts and enter a Y for “Yes”. 



Labor & Delivery - Date of Birth 
The date of birth populates from the entry on the Child tab. Stop and double-check the date of birth with hospital 
medical records. If the date of birth is correct, tab to the “Time of Birth” field. 

If the date of birth is wrong according to the hospital records, go back to the Child tab and correct the date in the Child 
Information paragraph. This will change the date of birth in the Infant’s Date paragraph. 



Labor & Delivery - Time of Birth 
Enter the time of birth as military time. Enter all four digits to avoid invalid input error messages. 

Example: 
Converts to 2:00 AM Child’s Certificate

Example: 
Converts to 2:00 PM Child’s Certificate



Labor & Delivery - Attendant

The cursor first goes to the Attendant’s Title/Relationship dropdown. Enter the title or select from the dropdown. If it is 
other than what is listed, type the title or relationship to the child. 

Tab to the “Attendant’s Full Name” field, enter the attendant’s full name (Last, First, Middle)

Tab to the “Attendant’s License #” field, enter the attendant’s license number. The license number is required for MD, DO, 
or CNM/ARPN. 

Tab to the Copy Attendant to Certifier bar. If the attendant is the same as the certifier click on Copy Attendant to Certifier 
bar, this will automatically fill in the attendant’s information in the certifier section. 



Labor & Delivery - Certifier 

If the certifier is different than the attendant, enter the title or select from the dropdown. If it is other than what is listed enter 
the title or relationship to the child. 

Tab to the “Certifier’s Full Name” field, enter the certifier’s full name (Last, First, Middle)

Tab to the “Certifier’s License #” field, enter the certifier’s license number. The license number is required for MD, DO, or 
CNM/ARPN. 

Tab to the Date Certified field. Enter the date (MM/DD/YYYY). The date is required to register the birth record and must be 
completed. 



Labor & Payment Source

Tab to “Primary Source of Payment” field. Enter the primary source of payment or select from the dropdown list. If it is 
other than what is listed enter the source of payment in the field. 



Labor & Payment Pg 2
The Labor & Delivery pg 2 tab matches the second half of Labor & Delivery items on page 2 of the Hospital Medical Worksheet. 



Labor & Payment Pg 2 - Mother 
Transferred 

If “No” mother was not transferred to this facility, enter N and the remaining items in the paragraph will auto-fill. 

If “Yes” mother was transferred to this facility, enter Y. 
• Tab to the In “State/Out of State” field. The field defaults to Iowa. If mother was transferred from out of state and 

delivered at this hospital choose Out-Of-State from the drop down. 

• Tab to “Transferred From” field. Enter or choose the name of the hospital from the dropdown. If the hospital is not 
listed in the dropdown, enter the name of hospital. Out of state hospitals will require entry. 

If “Unknown” mother was transferred to this facility, enter U and the remining items in the paragraph will auto-fill. 



Labor & Payment Pg 2 Delivery Weight

Tab into “Mother’s Weight at Delivery” field. 

Enter the delivery weight in whole numbers as documented in the mother’s medical charts.  

A validation error will appear if the mother’s weight is less than 75 lbs. or more than 350 lbs. Make note if this is accurate. 



Labor & Payment pg 2 
Characteristics of Labor & Delivery 
If none of the characteristics options were indicated in the mother’s medical charts, enter Y for “Yes” in the “NO 
Characters of Labor and Delivery Noted for This Pregnancy” field. The remaining items will auto-disable. Each 
characteristics items field will gray out. 

If the characteristics of labor and delivery were indicated in the mother’s medical charts, enter N for “No” in the “NO 
Characters of Labor and Delivery Noted for This Pregnancy” field. All the characteristics fields will open. 

Tab to the characteristics items indicated in the mother’s medical charts and enter a Y for  “Yes”. Indicate as many 
options that apply to this pregnancy. 



Labor & Payment pg 2 Method of Delivery 

Tab to the “Fetal presentation at birth” field. Enter the first letter of the title to 
select the fetal presentation or click on the dropdown arrow to choose the 
presentation. 

Tab to the “Final Method of 
Delivery” field.
 Enter the first letter of title or 
click on the dropdown arrow 
and choose the method of 
delivery.

If the final method of delivery is a 
cesarean, enter Y for “Yes” N for “No” 
or U for “Unknown” if trial of labor 
was attempted 

Note: If no trial of labor was attempted, then Antibiotics and/or Epidural during labor would be incorrect answers in the 
Characteristics of Labor and Delivery. 



Labor & Payment pg 2 Maternal Morbidity 

If none of the complications were indicated in the mother’s medical charts, enter Y for “Yes” in the NO Maternal Morbidity 
Noted for This Pregnancy field. The remaining items will auto-disable. Each characteristics items field will gray out. 

If complications were indicated in the mother’s medical charts, enter N for “No” in the “NO Maternal Morbidity Noted for This 
Pregnancy” field. All the characteristics fields will open. 

Tab to the complication items indicated in the mother’s medical charts and enter a Y for  “Yes”. Indicate as many options 
that apply to this pregnancy. 



Newborn 
The Newborn tab matches the first half of the Newborn items on page 3 of the Medical Birth Worksheet. 



Newborn-Weight 

Tab to the “Weight Unit” field. The weight unit defaults to G for “Grams”. 

If the baby was weighed in grams, Tab to the grams field. Enter the weight in whole numbers, up to four characters. 
Leading zeros are not needed. The pounds and ounces will auto-fill based on the number of grams when Tab to the next 
field. 

If the baby was weighed in pounds, change the weight unit to P for “Pounds” Tab past the grams field to the pounds and 
ounces fields. Enter the weight in whole numbers, up to two characters. Leading zeros will auto-fill when the user tabs 
forward. The pounds and ounces will auto-fill based on the number of pounds when tab to the next field. 



Newborn - Obstetric Gestation 
Tab to the “Obstetric Estimate of Gestation” field. Enter the gestation in whole numbers only (i.e., drop any fractions or 
partial weeks).  

Example

A validation edit will appear if the weight and 
gestation do not correspond. Double check the 
records and enter the correct data or make note if 
correct. 



Newborn - Sex 
Tab to the sex field. The sex populates from the entry on the child’s tab. 



Newborn - Apgar Score  
Tab to the 5-Min Apgar field. If the Apgar score were indicated on the medical chart, enter the Apgar scores in the field. A 
leading zero will auto-fill when Tab to the next field.  

If the 5-minute score is 6 or greater, the cursor will auto-fill the 10-minute score 8’s tab forward to the next field 

If the 5-minute score is 5 or less, the cursor will move to the 10-minute score. Enter the 10 minute Apgar score. Tab 
forward to the next field. 

If the Apgar test was not taken or score is unknown enter 99. 



Newborn-Plurality 

If a multiple-gestation birth event, see multiple birth pages in manual for information about entering and registering the set 
of birth records. Records from a multiple birth event should be registered consecutively. 

Enter the number of babies in this pregnancy/gestation in the Plurality field, this generates a number in the Multiple Match 
Number field. 

• Tab to the Birth Order-Number field and enter the birth order of this baby. Leading zeros will auto-fill. 

• Tab to the “Number Infants Born Alive This Delivery” field and enter the numbers of babies born alive in this birth 
event. 

• Tab pass the “Multiple Match Number” field to the Abnormal Conditions paragraph. 

The Plurality defaults to 01. If this is a single birth, tab to the Abnormal Conditions paragraph. The remaining fields in the 
Plurality & Birth Order default to 88 because they are not applicable to a single birth. 

 



Newborn - Abnormal Conditions 
If none of the conditions were noted in the baby’s charts, enter Y for “Yes” in the “No Abnormal Conditions Noted for the 
Newborn” field. The remaining item will auto-disable. Each condition items fields will be grayed out. 

If abnormal conditions were indicated in the baby’s medical charts, enter N for “No” in the “NO Abnormal Conditions Noted 
for the Newborn” field. All the characteristics fields will open. 

Tab to the abnormal condition items indicated in the baby’s medical charts and enter a Y for  “Yes”. Indicate as many 
conditions documented on the baby’s chart. If “Significant birth injury requiring intervention” is selected, enter the specific 
injury as documented in the delivery records. 



Newborn - Congenital Anomalies 
If none of the conditions were noted in the baby’s charts, enter Y for “Yes” in the “No Congenital Anomalies Noted for the 
Newborn” field. The remaining item will auto-disable. Each condition items fields will be grayed out. 

If congenital anomalies were indicated in the baby’s medical charts, enter N for “No” in the “NO Congenital  Anomalies Noted 
for the Newborn” field. All the congenital anomalies will open. 

Tab to the anomaly items indicated in the baby’s medical charts and enter a Y for “Yes”. Indicate as many conditions 
documented on the baby’s chart. 



Newborn pg 2 
The Newborn pg 2 tab matches the second half of Newborn items on page 3 of the Medical Birth Worksheet. 



Newborn pg 2 - Infant Transferred 
Tab into “Was Infant Transferred” field. If infant was not transferred to another facility within 24 hours of delivery, enter N for 
“No” the remaining items in the paragraph will auto-fill. 

If the infant was transferred to another facility within 24 hours of delivery, enter Y. 

• Tab to the In “State/ Out of State” field: The field defaults to Iowa. If the infant was transferred out of state within 24 
hours of delivery, chose Out-of-State from the dropdown. 

• Tab to the “Transferred To” field. Enter or choose the name of the hospital from the dropdown. If the hospital is not 
listed on the dropdown enter the name of the hospital. Out-of-State hospital will require date entry. 

• If “Unknown” infant was transferred to another facility within 24 hours of delivery, enter U and the remaining items in the 
paragraph will auto-fill. 



Newborn pg 2 - Infant Alive Status 
Tab to the “Infant Alive Status” field. Enter the letter corresponding to the status of the infant to choose from the drop-
down list. 

Y=Yes (Alive)
N=No (Deceased)
T=Transferred
U=Unknown 

A validation edit will appear if it is indicated that the baby is deceased. Double-
check the discharge records and either select Re-Key to correct the entry or 
select the bypass if the data is accurate. 

*Users are required to contact the State Birth Registration staff if the infant was 
not living at the time of reporting and make a NOTE in the record confirming the 
date of death and the name of the facility (funeral home or hospital) that took 
possession of the body. This is to ensure the infant deaths are properly 
registered.*



Newborn pg 2 - Mother Breastfeeding

Tab to the “Mother Breastfeeding/Pumping At Time of Reporting” field. Enter the letter corresponding to the status of 
time of the report or choose from the dropdown list. 

Y=Yes 
N=No 
U=Unknown 

Breastfeeding/pumping status is “at the time of this report.” If unknown, make note and explanation in record. 



Newborn pg 2 - Prenatal Care Study 

Tab to the “Prenatal Care Study” field. If birth mother did not participate in the study, or there is no number available 
enter Y for “Yes” in the “Did Not Participate/No Number Available” field. The “Barrier’s Code” field will auto-disable. 

If the mother participated in the study, enter N for “No” in the “Did Not Participate/No Number Available” field. 

Tab to the “Barrier’s Code” field. Enter the code number from the bottom of the study form. 

Enter U for “Unknown” in the “Did Not Participate/No Number Available” field and the remaining items in the paragraph 
will auto-fill. 



Newborn pg 2 - Newborn Screening
Tab to the “Did Infant Received Newborn Screening” field.

If “Yes” enter Y and tab to the ‘If Yes, Code Number” field. Enter the code number from the lab form. A validation edit will 
appear if the field is left blank. Enter U for “Unknown” if the number is not known. 

If the infant did not receive the newborn screening, enter N. Tab to “If NO, Reason Why” field, and select from the 
dropdown the reason why the screening was not performed. 



Newborn pg 2 - Hearing Screening
Tab to the “Did Infant Received Newborn Hearing Screening” field.

If “Yes,” infant did receive the newborn hearing screening, enter Y, the “If No, reason why” field will auto-disable. Tab to 
the next field. Enter U for “Unknown” if the number is not known. 

If “No,” the infant did not receive the newborn hearing screening, enter N.  Tab to the Reason Why field and select from 
the dropdown the reason why the screening was not performed.



Newborn pg 2 - Custody 
Tab to “Was Infant Removed from Birth Mother’s Custody?” field.

Enter N for “No” if the mother is maintaining custody of the baby. 

Enter Y for “Yes” if the birth mother is NOT maintaining custody of the infant and was removed. A validation edit will 
appear. Choose appropriate validation. 

There are three instances when the hospital will need to indicate on the record that the infant was removed from the birth 
mother’s custody. 

• The first instance would be an adoption. The birth mother declares this herself on the Birth Mother’s Worksheet. 
• The second would be a surrogacy where there is a court order agreement.
• The third instance would be a court order removal. The child is removed at time of birth by the Department of Human 

Services (DHS) or law enforcement. There must be a court order to mark removal, and the court order MUST be 
scanned & attached to the record.



Fees & Completion 

The Fees & Completion tab matches items on page 4 of the Medical Birth Worksheet



Fees & Completion - Fee Payment Status 
Paid

Tab to the Registration & Certified Copy Fees field. Enter the payment status

Only one payment status may be selected. If a second status is selected, the first one selected will automatically un-select. 

If the fee status is “Paid” press the spacebar to select fee type. Tab to the method of payment and select the corresponding 
check box for the appropriate payment method by pressing the spacebar. 

Tab and enter the check/hospital check/money order number. If a credit card payment is accepted, and the hospital check 
number is not available, leave the check number field blank, and enter $35.00 in the amount portion. 

Tab and enter the amount of the payment. The decimal points will auto-fill when tabbing forward. 



Fees & Completion - Fee Payment Status 
Not Paid or Waived  

If the fee status is “Not Paid” enter the fee status of “NOT PAID” in the field or use drop-down. The rest of the items in the 
paragraph will auto display when tabbing out of the field.  

If the fee status is “WAIVED” enter Waived in the field. Tab to the “Reason Why” field. Select the reason from the drop 
down. 



Fees & Completion - Statuses

The cursor will bypass the Paternity Affidavit Status to the next paragraph, if spouse information is obtained.

If there is NOT a spouse and the Voluntary Paternity Affidavit form has been completed, click in the check box or press the 
spacebar on the checkbox to select Paternity Affidavit has been completed and being mailed. 

The cursor will move on to the Surrogate/Gestational Carrier Birth checkbox located in the Registration Status paragraph. 
Click in the check box or press the spacebar to select only if applicable. 

Tab to Birth mother invoked Safe Haven, mark only if applicable.

Tab Mother Refused to sign (Birth Mother’s Worksheet) and mark only if applicable. Make notes in record if any apply. 



Record Completion 
If the record is complete, enter Y for “Yes” in the “Record Complete” field, tab, and then click on the green Save button 
located in the upper right corner of the screen. They system will auto-fill the date and the user’s name that completed the 
record. 

Two pop-up messages appear indicating the birth record is numbered and the record is saved successfully. Click Yes when 
it asks to close current window. 

If there are more births to be registered click the File menu drop down, New, Birth, Leave.
This will create a new record. 

When the record is complete, and a State File Number has been assigned, you can no longer make any edits/changes to 
the record. If something needs to be changed contact the Birth Registration staff with the Bureau of Health Statistics. 



Record Completion - Validations 
Overridden

If Record Completion equals “Yes” but validation edits have been overridden, a pop-up message will appear. The message 
can vary based on the type of the validation. Click the OK button and close the browser. 

The record will still be submitted for registration; however, a State file number will not be assigned until the State vital 
records staff have reviewed and accepted it. 

Validations can be reviewed by selecting Actions on the main menu 
bar. Click on Review Overrides/Queries. Clicking the green GO 
button will take you to the field in question. 



Scan & Attach Birth Worksheets

Scan the Birth Mother and Hospital Medical Worksheets through your scanner. Choose a location to save the worksheets 
(i.e. desktop, drive, a folder you created). Give it a file name (i.e. Child’s last name and DOB). It works best if the documents 
are saved as a PDF.

Select one of the 2 options: 
• Load Image: If you have a scanner that routes it to a file document requiring you to save it as a file, use this option.

• Load PDF/Documents: If you have a scanner that requires you to save it as a PDF or Word Document, use this option. 
This is the best option. 

Before you sign and save the record to be filed, scan and attach the Birth Mother’ and Hospital Medical Worksheet to the 
birth record. 



Scan & Attach Birth Worksheets

Scan the worksheets through your scanner which 
will require you to save the Image as jpeg or tiff on 
your computer. 

On the birth record go to the menu and click 
Action>Load Image.

Option 1: Load image from the File. If you have a scanner that requires you to save it as an image. 

Load Image screen will appear. Enter “Birth 
Worksheet” as the Description. 

Then click on the Browse button. 



Scan & Attach Birth Worksheets
On the open screen, find the saved 
image file. Click on the image file which 
will filter into the “File name” field. 

Click on the open button, which takes you 
back to the Load Image screen

On the Load Image screen, the file name 
populates in the “Locate File” field. Click 
the OK button. 



Scan & Attach Birth Worksheets

Image Editor screen pops up 
with the image of the attached 
document. 

Enter Birth-Registration from 
the Security Function field 
dropdown. 

Click Save to File button. 

To view the image, double click on the Image Count 
box located in the upper right-hand corner of the 
birth record. 



Scan & Attach Birth Worksheets

Scan the worksheets through your scanner which 
will require you to save the Image as PDF or a Word 
Document on your computer. 

From the record click on Actions > Load File 

Option 2: Load PDF/Documents (if you have a scanner that requires you to save it as a PDF or Word Document). 

Load File screen will appear. Enter “Birth 
Worksheet” as the Description. 

Then click on the Browse button. 



Scan & Attach Birth Worksheets
Go to where the worksheets is saved and find 
the saved PDF or word document file.

Click on the PDF or word document file which 
will fill into the “File name” field. 

Click the Open button, this will take the user 
back to the Load File screen. 

On the Load File screen, the file name 
populates in the “Locate File” field. Click the 
OK button. 



Scan & Attach Birth Worksheets

File Load screen pops up with the attached 
document. 

Enter Birth-Registration in the Security 
Function field. 

Click the Save to File button. 

To view the image, double click on the 
Image Count box located in the upper 
right-hand corner of the birth record.



Multiple Birth Event - BABY A

Enter all information for BABY A until the Newborn tab, Plurality section. 

The plurality field defaults to 1. For a multiple birth event, enter 2, 3 etc. The system will also generate a birth match 
number in the “Multiple Match Number” field. 

Tab to the Birth Order Number field and enter the birth order which will be 1 for the first baby born, then tab to the “Number 
of Infants Born Alive This Delivery” Field and enter the number of infants born alive in this birth event. 

Continue entering the rest of the items until the Fees & Completion tab. 

In this example, this multiple birth event is the Birth Mother’s first pregnancy.
 
Baby A: Begin the birth record: File>New>Birth (or Ctrl+I)



Multiple Birth Event - BABY A

On the Fees & Completion tab enter all the items and enter Y for “Yes” in the Record Complete Field. Upload and attach 
Baby A’s birth worksheet. 

After worksheet is attached, go to the File Menu, and click Save As Twin Without Edits. This will open the second record for 
Baby B. 

Baby A’s record will move to the pending Work Queue to be signed off on and completed after Baby B’s information has 
been entered and the record completed. 

    
   



Multiple Birth Event – BABY B
Go to the Child’s tab and begin entering Baby B’s information in the duplicate checking paragraph. Then click on Check for 
Duplicate bar. The information from the duplicate check will automatically fill the child’s information fields. 

    
   

Tab to the Mother tab and enter Baby B’s medical record number. All the remaining items on the Mother tab are pre-
populated from Baby A’s information. 

Skip over the Mother Pg 2, Mother Pg 3, and Spouse (if applicable) tabs to the Informant tab. Those fields are also pre-
populated from Baby A’s information. 



Multiple Birth Event – BABY B
On the Informant Tab, the informant's name is pre-populated. Enter all the remaining items on this tab. 

Tab to the Prenatal tab, and the information is pre-populated except for the Previous Live Births and Other Pregnancy 
Outcomes paragraph. Enter “N” for No Previous Live Births field.  

If Baby A is Alive: Tab to the Number of Previous Live Births-Now Living enter 1 and tab to Number of Previous Live Births-
Now Deceased field, enter 0. Tab to Date of last live birth and enter Baby A’s date of birth. 

If Baby A was Alive and then Died: Tab to the Number of Previous Live Births-Now Living enter 0 and tab to Number of 
Previous Live Births-Now Deceased field, enter 1. Tab to Date of last live birth and enter Baby A’s date of birth. 

    
   



Multiple Birth Event – BABY B
Tab to No Other Pregnancy and enter “Y” for Yes if Baby A is ALIVE and there are no other prior previous outcomes not 
resulting in live births. The remaining fields in this paragraph will auto populate. 

If Baby A in this birth event is Not born alive (e.g., miscarriage or stillborn), enter “N” in the No Other Pregnancy Outcomes Not 
Resulting in Live birth field. 

Then enter the total number of date of the last other pregnancy outcomes. 

    
   

A validation error will appear. Override if correct and make a note in the record. 



Multiple Birth Event – BABY B

Continue entering all items in the Prenatal, Labor & Delivery, and Labor & Delivery Pg 2 tab until the Newborn Tab, plurality 
section. The Plurality and Birth Match Number default to Baby A. 

    
   

Tab and enter the birth order of Baby B and the total number born alive in this delivery. 

Continue entering the remaining fields for Baby B until you reach the Fees & Completion Tab. 

On the Fees & Completion tab enter the fee status, then Tab to the Record Complete field and enter Y and Save. The record 
will assign a state file number. Upload and attach Baby B’s Birth Worksheet. Baby B record is complete, now Baby A needs 
to be completed. 

If multiple birth event has more than two, repeat the same process 

The Multiple Match Number 
must be the same as Baby A, or 
the record will not be able to be 
signed off on. 



Multiple Birth Event – Registration
Go to the Home page, go to the Work Queues, and click on B Facility Record-Pending. This will take you to the pending work 
queue were Baby A listed. 

Double click and open Baby A. 



Multiple Birth Event - Registration 
Go to the Fees & Completion tab, enter “Y” in the Is Record Complete field, and Green Save in the right had corner. The 
record will assign a state file number. 

    
   

Two pop-up messages appear indicating the record has been numbered (if there are no validations for the State to 
review) and the record is saved successfully. Click Yes to leave the record. 

A final message will appear asking if you want to leave the record, click leave. This will return you back to the prior 
screen. 

When the record is complete, and a State file number has been assigned, no edits/changes can be made to the record. 



Registration Rejected-Review Errors

Some validation edits permit the user to select Queried and Verified for items which are correct as entered according to the 
hospital records or overridden. This allows the record to be saved as complete and submitted for registration; however, it 
puts the record on hold until State vital record staff have reviewed it. 

When State staff review the record, they will make a determination based on looking at the Review Errors and Queries, the 
questionable date as entered in the fields, missing documentations and any notes made by the hospital staff. 

 

 
If the record is found unacceptable as is, then it will be “Rejected” back to the hospital and accessible to the user for 
clarification or correction. There will be a note as to why it is being rejected.  An email notification will be emailed to the user. 

   



Registration Rejected - Notification 

A system generated email will go out to the hospital user when the record is rejected. Any issues with the birth record should 
be resolved promptly to facilitate registration by logging in and checking the Work Queues- B Facility Record-Rejected. 
   
   

Hospital users should regularly check their Work Queues for Rejected records, as well as checking their Pending Queue to 
ensure that all records are filed within 7 days of the child’s date of birth. 



Registration Rejected - Work Queues
The Work Queues are located on the Home page. Click on the B Facility Record-Rejected to access the rejected record(s). 

   
   

To display the rejected record, either double click the entry, or highlight and select the display command at the top right-hand 
corner.



Registration Rejected - Review Notes
Go to the main menu bar and select Actions>Show Notes or double click on the 
Notes Count button located on the top screen to see the reason for the rejection. 

Click the View button to read the entire message. 

The notes are created by hospital users and State staff to address a specific field. 
Each field may have multiple notes. For example; one originally from the hospital 
user, and another from a State staff when rejecting the record. 



Registration Rejected - Resubmitting

Make the appropriate correction.

If no corrections are necessary but validation of the data in the record or the required supporting documentation is needed:

• Make a Note in the record to validate the data or attach the Birth Worksheet/supporting documentation. 

• Go to the Fees & Completion tab and go to the Record Completion paragraph. Enter Y for “Yes” and Save. If the 
validations cannot be changed, the record will run though the same process as before and be reviewed by that State 
staff prior to being accepted for registration. 



State Office Use Only 
The “Flags” tab is for State office use only for after the birth record is registered. Therefore, the fields are inactivated at the 
facility level. 



Summary of Fee Report - Required Report
The Summary of Fee Report is system generated and will pick up only those records saved as complete, including those not 
State-File-Numbered due to validations that were overridden and must be reviewed by the State. 

A Summary of Fee Report must be submitted weekly to the State listing the birth records registered during that a week and 
the fee payment status for each. 

A copy of the Fee Report must be signed and dated, then mailed to the State birth registration staff along with fee payments. 
Fees are payable by check or money order only. If the hospital accepts cash or credit card payment, the hospital must issue a 
check to the State. Hospital may choose to bill new parents capable of paying the fee, and then issue a hospital check on 
behalf of the parent(s). Hospitals may not charge the parents a billing fee. 

The Summary of Fee Report should also be used by the hospital to audit with their delivery room log to ensure that record has 
been filed for all live-born births occurring at or en route to the hospital. 



Summary of Fee Report - Printing Report
To access the Summary of Fee Report, go to menu and click Batch>Reports

 

Select Birth  

Select Summary of Fees (Local)



Summary of Fee Report - Printing Report

Click on Record is Complete Date and the parameter field will open.

 

Enter the Range of Completion Dates in the parameter field. 
• You must use slashes between the month, day, and year-not hyphens
• You must enter two dates, even if they are the same date (indicates one day’s worth of registered records) 
• Use a comma to separate the two dates

Click Preview button to view report



Summary of Fee Report - Printing Report

Click the Print icon in the top right corner of the window. 

Click the X in the browser tab to close the report window. 

The Summary of Fee Report will show all the birth records filed as complete during the time periods specified in the date 
range. 

All fee payments (checks/money order) should match with the total amount for the reporting period. If not, write edits on 
summary fee so checks and total match. 



Summary of Fee Report - Preview Layout

Close Report

Hospital 

Birth Records filed as 
complete during the range of 
dates indicated. 

Number of pages

Print

State Use Only

Totals based on data 
entry in the recordsInformation pre-populates

Signature and date



Contact Information

Birth Registration Staff     
Provides assistance to hospital staff with concerns about establishing birth records. This 
includes general questions on the Birth Worksheet, querying records with proof of 
information, establishing paternity, summary fee reports, etc.

515-725-2555

Program Planner    
Provides oversight for the Birth Registration Program. This includes providing training on 
birth registration and educational training.

515-281-3266

IVES Helpdesk    
Provides technical support for the Electronic Birth Registration System, IVES-NX.

866-309-0831

Paternity Staff    
Provides assistance to parents with general questions pertaining to processing paternity 
affidavits, rescissions, and court order paternity.

515-725-2567
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